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1  Introduction 

The Fabasoft Digital Asset Management is the intelligent, central, continuously available software 

system for your digital assets. Global teams as well as agencies, suppliers and resellers can quickly 

find the right content, use it consistently, administer and edit it with ease and comfortably release 

and share it. 

 

2  Digital Asset Management Dashboard 

The digital asset management dashboard is your access point to the digital asset management. 

When you are added as an app user to a DAM configuration, a dashboard is automatically created 

and placed on “Home”. If you are removed as an app user, the dashboard is removed, too. 

The digital asset management dashboard is divided in following areas: 

• Recently Used Assets 

Shows the assets that have been recently used by you. 

• Asset Shelf Structure 

Shows the top-level asset shelves that are used to manage the assets. 

• All Asset Shelves 

Shows all asset shelves independent of the level. 

• Transfer Collections 

Shows your transfer collections, if at least one transfer collection exists. 

You can execute following actions: 

• Create Asset Shelf 

With the “Create Asset Shelf” action you can create new asset shelves. 

• Create Transfer Collection 

With the “Create Transfer Collection” action you can create new transfer collections. Transfer 



 

 Fabasoft Digital Asset Management 5 

collections are used to collect assets from different folders and shelves and make them 

available as a public link. 

• Switch to Configuration 

With the “Switch to Configuration” action you can view the configuration that is associated with 

the dashboard.  

• Settings 

With the “Settings” action you can define common properties of the digital asset management 

dashboard like the logo or notification setting. 

3  DAM Configuration 

In the DAM configuration, you can define download formats, categories, user-defined forms, BPMN 

processes, thesauri, available optional fields, general settings and app users. 

DAM configurations can be created in the organization by the organization owner, organization 

administrator or payment user. The defined DAM administrators can edit the corresponding DAM 

configurations. 

Note: As app administrator, you can use the digital asset management dashboard to access to the 

corresponding configuration. 

Areas 

The DAM configuration is divided in following areas: 

• Download Formats 

Shows the available download formats. You can modify the download formats (“Properties” 

context menu command) or delete them (“Delete” context menu command). 

Note: The “Original Format” cannot be deleted. 

• Asset Shelf Structure 

Shows the top-level asset shelves that are used to manage the assets. 

• All Asset Shelves 

Shows all asset shelves independent of the level. 

• External Content Sources 

Shows the configured external data sources that can be used to import assets. The “Connect 

Adobe Stock” action allows you to store the connection data of an Adobe Stock service account. 

In addition, enter a destination shelf for the assets, the maximum number of assets to be 

imported per import process, the interval at which an automatic import is to be performed and 

the media types to be imported. 

In the external data source, following actions are provided: 

o Execute Import Now 

Starts the import interactively. 

o Deactivate Connection 

If you no longer want to import assets, you can disable the connection. 

o Show Profile Data 

Displays your Adobe Stock profile data. Click the “Buy Credits” button to purchase additional 

credits from Adobe Stock. 

o Show Purchase History 

Displays your Adobe Stock purchase history. 
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• Forms and Categories 

Shows the available forms and categories. 

Note: To be able to store forms and categories from a different context, you must adjust the 

Restrict Shortcuts Within Teamroom field in the configuration settings accordingly. 

• Processes 

Enables the creation of BPMN processes for processing digital assets within a workflow. 

• Templates 

In the create dialog (e.g. “New” context menu command in a Teamroom) the templates are 

displayed according to the grouping by the template categories. 

• Text Modules 

The defined text modules can be inserted into Word documents. 

• Thesauri 

Shows the thesauri in which terms for tagging assets can be managed. At least one thesaurus 

has to be created so that the tagging can be used. The default thesaurus for new terms can be 

defined in the settings of the DAM configuration. In this way, new terms can be created directly 

during tagging. If no standard thesaurus is specified, only the predefined terms in the thesauri 

can be used. 

Duplicate terms can be merged using the “Tools” > “Merge Term” context menu command. The 

term to be replaced is also replaced in all places of use. 

• Presettings 

Shows the presettings provided by the configuration (display settings, search forms, time 

intervals). 

• Failed Background Tasks 

Shows failed background tasks (only visible, if at least one failed background task is available). 

You can perform following manual actions: “Define Next Execution”, “Send Link” and “Delete”. 

Actions 

You can execute following actions: 

• Create Download Format 

With the “Create Download Format” action you can create download formats for images, 

audios, videos and documents (generic content). Depending on the type, you can specify 

different parameters. In addition, you can define who is entitled to use the download format. 

• Create Asset Shelf 

With the “Create Asset Shelf” action you can create new shelves. 

• Translations 

The “Translations” action can be used to export or import a CSV file containing the multilingual 

names of the customizing objects. This enables an external translation. 

• Settings 

With the “Settings” action you can define further configuration settings. 

• Team 

With the “Team” action you can define app administrators who are allowed to edit the 

configuration. App members are entitled to use the digital asset management. The respective 

access rights are defined in the DAM shelves. 

Note: Based on the defined users, the consumed licenses are calculated. 

Settings 
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“General Settings” tab 

• Name 

The name of the configuration. 

• Subject 

Defines an additional description of the configuration. 

• Mindbreeze InSpire Service 

Defines the Mindbreeze InSpire Service that is used for classification. 

• Restrict Shortcuts Within Teamroom 

Defines which type of shortcuts may be stored in the configuration. 

• Restrict the Downloading or Opening of Content on the Device 

Allows to restrict team members who can open or download content on the device. 

• All Team Members May Add Members 

Defines whether all team members can add users to the team or only team members with full 

control. 

• Restrict Team Members 

Defines the organizations, organizational units, teams and external organizations whose 

members may be added to the configuration. 

• Enable Advanced Mode 

Advanced mode includes, for example, working with multiple shelves, as well as managing 

templates and presettings. 

• Main Administrator 

Defines the user who will receive the automatically generated e-mail messages concerning the 

configuration. Otherwise, all app administrators receive the e-mail messages. The user is also 

listed as contact in case of missing permissions. 

• Support Team 

The support team handles the organization-internal management of support requests in the 

respective context. 

• Activate Trace Output 

For example, as a form designer, when you use expressions for calculation or validation, it can 

sometimes be difficult to identify errors in the expressions. To simplify analysis, you can write 

trace output to the web browser console (cooobj.Trace("string"); or 

cooobj.Trace("string", value);). 

“DAM Configuration” tab 

• Fields for Digital Assets 

Defines which optional fields are to be displayed for assets. 

• Mandatory Fields for Digital Assets 

Defines digital asset fields that must contain a value. 

• Minimum Number of Terms to Be Assigned 

Defines the minimum number of terms that must be defined for an asset. 

• Registering New Digital Assets 

Defines whether the registration dialog is opened when new assets are stored in an asset shelf. 

• Automatically Generate Terms When Registering Digital Assets 

Defines whether keywords are automatically generated as terms if they do not already exist. 

Note: Registering New Digital Assets has to be enabled. 
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• Subordinate Generated Terms to This Term 

The generated terms are subordinated to the specified term. 

• Determine Location From GPS Coordinates When Registering Digital Assets 

Defines whether location information should be determined from GPS coordinates via a 

geotagging service. 

Note: If enabled, the “Tools” > “Show on Map” context menu command of assets allows 

displaying the locations on a map. 

• Connection to Geotagging Service 

Defines the access information to a geotagging service. 

Note: You need an account at https://developer.here.com/. This account must be purchased 

separately. 

• Use Licensing 

Defines whether the fields for licensing are displayed. Assets without a valid license can only be 

downloaded by app administrators. 

• Fields for Licensing 

Defines which fields are displayed for licensing. 

• Mandatory Fields for Licensing 

Defines licensing fields that must contain a value. 

• License Types (License Text Changeable) 

Defines license types for which the license text can be manually adjusted per asset. 

As Scope Note of the license type, you can define the license text. This text is taken over as 

License Text when choosing a license type for the asset. In the Related Terms, you can define 

usage types, which will be prefilled when selecting a license for an asset. 

• License Types (License Text Not Changeable) 

Defines license types for which the license text cannot be adjusted manually. 

As Scope Note of the license type, you can define the license text. This text is taken over as 

License Text when choosing a license type for the asset. In the Related Terms, you can define 

usage types, which will be prefilled when selecting a license for an asset. 

• Usage Types 

The defined usage types can be assigned to assets. 

• Allow Editing of Image Properties (Exif, IPTC, XMP) 

Defines whether image properties of JPG and PNG images can be modified. 

• Editable General Properties 

Defines general image properties that are editable. 

• Editable Exif Properties 

Defines Exif image properties that are editable. 

• Editable IPTC Properties 

Defines IPTC image properties that are editable. 

“Logos” tab 

The defined logos and the background image are used for the DAM configuration and for all 

personal dashboards.  

“Default Values” tab 

• Default Thesaurus for New Terms 

If a default thesaurus is specified, new terms can be created directly during tagging. 

https://developer.here.com/
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• Default Categories 

When an object is created, the specified category is assigned according to the defined object 

class. In the Apply to field, you can specify whether the setting applies to instances, templates, 

or both. 

• Default Processes 

When an object is created, the specified process is assigned according to the defined object 

class or category. In the Apply to field, you can specify whether the setting applies to instances, 

templates, or both. 

• Default Background Tasks 

When an object is created, the specified background tasks are assigned. 

“Content Settings” tab 

• Allow Comments 

Defines whether PDF annotations can be applied to documents. 

• Allow Public Links 

Defines whether public links may be published. 

• Generate Cover Sheet for PDF Overviews of Documents 

Defines whether a cover sheet is generated for PDF overviews of documents. 

• Use Watermarks 

Defines whether documents are automatically converted into protected PDF documents with a 

definable watermark. 

Download Formats 

You can define the following download formats. When downloading, the content is converted 

according to the selected download format. 

Download Format for Audios 

• Output Format 

As output formats MP3, OGG and “Original Format” are available. 

Download Format for Images 

• Adjust Image 

o Do Not Adjust 

The image is not changed. 

o Adjust Aspect Ratio and Size 

Aspect Ratio: The image is cut corresponding to the defined aspect ratio. If a maximum size is 

additionally defined, this is taken into account. 

Maximum Size: Defines the maximum height and width of the image. The image is not 

distorted but scaled to the desired size. 

o Adjustable at Download 

Image adjustments can be set by the user when downloading. 

• Output Format 

As output formats JPEG, PDF, PNG, TIFF and “Original Format” are available. 

Download Format for Documents (general content) 

• Output Format 

As output formats PDF and “Original Format” are available. 
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Download Format for Videos 

• Resolution 

Defines the resolution to which the video should be converted. Only if the resolution of the 

video is higher than the specified one, it will be converted. 

• Output Format 

As output formats MP4, OGV, WEBM and “Original Format” are available. 

General 

• In addition, the download format “Original Format” is available by default (contents are 

downloaded unchanged). 

• You can use the Permissions field to specify the users who are offered the download format. 

• Sample download formats are provided, which you can customize or delete as required. 

3.1  Getting Location Information From Images 

When registering images, location information can be determined from the GPS coordinates. For 

this purpose, a geodata service can be stored in the DAM configuration. 

Here Maps Account 

You need an account at https://developer.here.com/. This account must be purchased separately. 

When licensing, make sure in particular that the results of the geodata query are stored in the 

Fabasoft Private Cloud. 

After you have created an account, switch to the projects in your user menu. Select the desired 

payment plan. Make a note of the “App ID” and the “App Code” in the “JAVASCRIPT/REST” area. 

DAM Configuration 

To store the Here Maps data in the DAM configuration, proceed as follows: 

1. Navigate to the DAM configuration. 

2. Click the “Settings” action. 

3. If necessary, enable the Register New Digital Assets option. 

4. Enable the Determine Location From GPS Coordinates When Registering Digital Assets option. 

5. Click “Create” in the Connection to Geodata Service field. 

6. Select the Here Maps technical data. 

7. Enter the App ID and App Code of you’re here Maps account. 

8. Click “Next”. 

9. Click “Next” to close the DAM configuration. 

3.2  Configuration of Adobe Stock 

The prerequisite for establishing the connection to Adobe Stock is a valid “Adobe Stock API 

Application”. Details on how to set up such an application can be found here: 

https://adobeio-prod.adobemsbasic.com/apis/creativecloud/stock/docs.html#!adobe/stock-api-

docs/master/docs/getting-started/02-register-app.md 

https://developer.here.com/
https://adobeio-prod.adobemsbasic.com/apis/creativecloud/stock/docs.html#!adobe/stock-api-docs/master/docs/getting-started/02-register-app.md
https://adobeio-prod.adobemsbasic.com/apis/creativecloud/stock/docs.html#!adobe/stock-api-docs/master/docs/getting-started/02-register-app.md
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When creating such an application from your Adobe console, a public key for a signature certificate 

is required. Your Adobe console will provide you with the credentials required for connection setup 

(API Key (Client ID), Client Secret, Technical Account ID, Organization ID and a JWT Signature Certificate). 

DAM Configuration 

To store the Adobe stock data in the DAM configuration, proceed as follows: 

1. Navigate in the DAM configuration. 

2. Click the “External Content Sources” widget. 

3. Click on the "Connect Adobe Stock" action. 

4. Enter the credentials of the “Adobe Stock API Application” and upload the JWT signature 

certificate. 

5. Click “Connect”. A connection test will be performed automatically. 

4  Asset Shelves 

Asset shelves are used to manage the digital content and to define the access rights (“Team” 

action). 

You can store your content directly in the shelf at top-level, or you can define a sub-structure with 

additional asset shelves or folders (“New” context menu command). 

Note:  

• The defined team of an asset shelf only applies to this asset shelf. Contained asset shelves 

define their own access right context. 

• When creating a folder, terms can be assigned directly. Terms from the superordinate folder 

are proposed. 

• If fields are defined as mandatory fields in the digital asset management configuration, the 

“Show Invalid Assets” context menu command of the asset shelf can be used to generate an 

overview of assets with missing values in mandatory fields. 

Settings 

“General Settings” tab 

• Name 

The name of the configuration. 

• Subject 

A description of the configuration. 

• Enable Notification 

Defines for the current user whether notifications are sent. 

• Restrict Shortcuts Within Teamroom 

Defines which type of shortcuts may be stored in the shelf. You can restrict the permitted 

shortcuts to objects that are assigned to the organization or to objects that are assigned to the 

shelf. In this way, you can prevent, for example, that shortcuts are stored to which the 

members of the shelf do not have access. 

• Restrict the Downloading or Opening of Content on the Device 

Allows to restrict team members who can open or download content at the device. 
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• All Team Members May Add Members 

Defines whether all team members can add users to the team or only team members with “Full 

Control”.  

Members with change access may grant or revoke change access or read access to other 

members. Members with read access may grant or revoke read access to other members. 

• Restrict Team Members 

Defines the organizations, organizational units, teams and external organizations whose 

members may be added to the shelf. If the list does not contain any entries, members can be 

added without restriction. 

• Main Administrator 

Defines the user who will receive the automatically generated e-mail messages concerning the 

shelf. Otherwise, all shelf administrators receive the e-mail messages. The user is also listed as 

contact in case of missing permissions. 

• Support Team 

The support team handles the organization-internal management of support requests in the 

respective context. 

“Contract/License Documents” tab 

• Contract/License Documents 

The stored documents can be referenced in the assets. 

 “Default Values” tab 

• Default Thesaurus for New Terms 

If a default thesaurus is specified, new terms can be created directly during tagging. 

• Default Categories 

When an object is created, the specified category is assigned according to the defined object 

class. In the Apply to field, you can specify whether the setting applies to instances, templates, 

or both. 

• Default Processes 

When an object is created, the specified process is assigned according to the defined object 

class or category. In the Apply to field, you can specify whether the setting applies to instances, 

templates, or both. 

• Additional Default Background Tasks 

When an object is created, the specified background tasks are assigned. 

Note: The default properties overwrite or extend the settings in the configuration. 

“Content Settings” tab 

• Allow Comments 

Defines whether PDF annotations can be applied to documents. 

• Allow Public Links 

Defines whether public links may be published. 

• Generate Cover Sheet for PDF Overviews of Documents 

Defines whether a cover sheet is generated for PDF overviews of documents. 

• Use Watermarks 

Defines whether documents are automatically converted into protected PDF documents with a 

definable watermark. 

Note: The content settings overwrite the settings in the configuration. 
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“Templates” tab 

Shows the templates provided by the shelf. In the create dialog (e.g. “New” context menu 

command) the templates are displayed according to the grouping by the template categories. 

“Text Modules” tab 

Shows the text modules provided by the shelf that can be inserted in Word documents. 

“Processes” tab 

Shows the processes provided by the shelf. 

“Presettings” tab 

Shows the presettings provided by the shelf (display settings, search forms, time intervals). 

5  External Areas 

External areas can be created in asset shelves. The team defined in the parent asset shelf 

automatically has the corresponding rights in the external area. Users with full control in the asset 

shelf can extend the team of the external area. In this way, for example, a close collaboration with 

an external graphic design agency can be realized, which should only have access to the external 

area. 

Note: The “Tools” > “Convert to” context menu command can be used, for example, to convert a 

folder to an external area and vice versa. 

6  Assets 

Assets are digital content such as images, documents or videos. If the asset is stored in an asset 

shelf, you will find the “Digital Asset” tab in the properties of the asset. Which fields are displayed is 

defined in the DAM configuration. 

• Name 

The name of the asset. 

• Alternative Name 

Defines another name for the asset. 

• Subject 

Defines a free-text as subject for the asset. 

• Terms 

The terms are used to tag the assets. 

• Description 

The description of the asset as free text. 

• Location 

The location of the asset (e.g. the location where the picture was taken). 

• Date 

The date of the asset (e.g. the date when the picture was taken). 

• Location Information 

Shows the location information determined from the GPS coordinates. 



 

 Fabasoft Digital Asset Management 14 

• Licensed From 

The asset is licensed as of the specified date. Assets with a not yet valid license cannot be 

downloaded (except by app administrators). 

• Licensed Until 

The asset is licensed up to the specified date. Assets with an expired license cannot be 

downloaded (except by app administrators). 

Note: If neither Licensed From nor Licensed Until is specified, all use cases can be performed as 

if the asset has a valid license. If only Licensed From is specified, the asset is licensed from this 

point in time (without expiration date). If only Licensed Until is specified, the asset is licensed up 

to this point in time (without start date). 

• License Type 

Defines the license type of the asset. The available license types are defined in the DAM 

configuration. A license type may be related to usage types, which will be prefilled when 

selecting a license. 

• Contract/License Document 

Defines the contract or license document of the asset. 

• License Text 

The license text as free text. 

• Useable for 

Defines the context in which the asset may be used. The available usage types are defined in 

the DAM configuration. 

• Right of Use 

The right of use of the asset as free text. 

• Copyright/Originator 

The copyright or originator of the asset as free text. 

• Creator 

The creator of the asset. 

• Provider 

The provider of the asset. 

• E-Mail Address 

The e-mail address of the provider. 

• Address 

The address of the provider. 

• Source 

The source of the asset. 

• Responsible for the Registration 

This field can be evaluated in the registration workflow to determine the user for the 

registration. 

Note: If the asset has already been registered, the Registered by field is shown that contains the 

user who performed the most recent registration. 

Note:  

• In the case of videos, the second at which the preview image is generated can be specified on 

the “Content” tab in the Generate Thumbnail at Second field. 

• Image properties (Exif, IPTC, XMP) of JPG and PNG images can be changed via the "Edit Image 

Properties” action (if defined accordingly in the DAM configuration). 
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Status 

Assets can have the following status icons (if licensing is enabled): 

• Yellow warning triangle (license information incomplete) 

Not all mandatory fields with regard to licensing contain a value. 

• Red exclamation mark (no valid license) 

The current date is before Licensed From or after Licensed Until. 

7  Registering Assets 

Assets that have not yet been assigned to an asset shelf can be registered to an asset shelf. In the 

course of registration, capturing metadata is possible. To do so, navigate to the desired asset and 

execute the “Register as Digital Asset” context menu command. Define an asset shelf as target. 

Metadata that can be extracted from the asset (e.g. Exif) is automatically taken over. The 

corresponding fields are highlighted in color and can be modified if necessary. 

Note:  

• To assign an asset to an asset shelf, you can alternatively cut the asset and insert it into the 

asset shelf. 

• In the DAM configuration, you can define that the registration dialog is displayed automatically 

when new assets are added. 

• You can also register several assets or entire folders containing assets at once.  

o The specified values can be applied to all assets (“Apply Values for All Digital Assets” button). 

o The name prefix is added to all asset names. 

o In the Digital Assets field, the values of individual assets can also be changed. If you want to 

set common values and also change individual assets, always apply the common values first 

(“Apply Values for All Digital Assets” button) before changing the values of individual assets. 

• If you register assets via an inbox, you can use the “Define Property value” action to store the 

desired destination shelf in the Preferred Registration Target property. This means that when you 

register, not the recently used shelf is suggested, but the shelf stored in the property. 

8  Re-Registering Assets 

Assets that are already assigned to an asset shelf can be re-registered to another asset shelf. In the 

course of re-registration, entering metadata is possible. To do so, navigate to the desired asset and 

execute the “Re-Register” context menu command. Define an asset shelf as target. 

You can also re-register several assets or entire folders containing assets at once. 

9  Converting Assets 

You can convert video files to MP4, OGV or WEBM. For audio files, MP3 and OGG are available. To 

do so, the “Save as <format>” context menu commands are available. The conversion runs in the 

background and may take longer depending on the size of the source file. The result of the 

conversion can be found in the properties of the multimedia file, on the “Content” tab in the File in 

Different Formats field. 
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10  Downloading Assets 

When you download an asset, you can select the download format. The formats defined in the 

DAM configuration, which are suitable for the type of the asset and which are allowed to use, are 

offered as download formats. 

Note:  

• If you select several assets, they are downloaded as ZIP file. 

• If you download a single image, the "Copy to Clipboard" button is also available. 

• If you select a download format for images that allows you to customize the image when you 

are downloading, you can use the “Edit” button to scale the image and specify an area. 

• If you select different types of assets to download, download formats are offered according to 

the selected types. Only those assets are downloaded, which can be converted to the selected 

download format. 

• If videos or audios are not available in the desired download format, an appropriate message is 

displayed and the conversion is started in the background. After conversion, you can run the 

download again. 

11  Tagging Assets 

If at least one thesaurus is defined in the DAM configuration, you can define terms on the “General” 

tab of your assets. Whether you can directly create new terms depends on whether a standard 

thesaurus for new terms is specified in the DAM configuration. 

12  Public Links to Assets 

When you create a public link to an asset (“Create Public Link” context menu command), you can 

also define the download format. 

Note: When creating a public link to a folder with different types of assets, download formats are 

offered according to the contained types. Only those assets are included in the public link that can 

be converted to the selected download format. 

13  Using Transfer Collections 

Transfer collections are used to collect assets from different folders and shelves and make them 

available as a public link. Transfer collections are assigned to a single user and cannot be managed 

together with other users.  

Note: Public links must be allowed for the asset shelves. 

Create a Transfer Collection 

You can use the “Create Transfer Collection” action to create transfer collections. If usage types are 

defined in the DAM configuration, you can define the required usage types for the transfer 

collection. Only assets that have all the necessary usage types can be placed in the transfer 

collection. If licensing is used, the assets must also have a valid license. 

Place the desired assets in the transfer collection (e.g. use copy and paste or use the “Add to 

Transfer Collection” context menu command).  
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Note:  

• If the asset has already been added to a transfer collection, this is indicated by a checkmark 

next to the respective transfer collection. Click on the corresponding transfer collection, if you 

want to remove the asset again. 

• You can also create a new transfer collection using the context menu. 

Close a Transfer Collection 

After you have placed the assets, you can complete the transfer collection and create a public link 

using the “Close” action. The transfer collection can still be edited, but closed transfer collections 

are no longer offered in the context menu of assets. 

Note:  

• If public links are disallowed afterwards, the assets of the corresponding shelf are no longer 

available in the public link of the transfer collection. This is indicated by a status symbol. 

• For closed transfer collections, additional public links can be created (“Manage Public Links” 

action). 

14  Integration in the Adobe Creative Cloud 

The Fabasoft Cloud Client offers an extension for Adobe Illustrator CC, Adobe InDesign CC and 

Adobe Photoshop CC to directly access the digital asset management of the Fabasoft Cloud. This 

allows you to search for images in your DAM shelves directly from within the Adobe product and 

embed them in your document via drag-and-drop. 

 

Note: If you have installed the Fabasoft Cloud Client before the Adobe products, you must uninstall 

and reinstall the Fabasoft Cloud Client to make the integration available.  

To embed an image in your document, proceed as follows: 

1. Open a document in Adobe Illustrator, Adobe InDesign or Adobe Photoshop. 

2. Open the “Window” menu and click “Extensions” > “Fabasoft Cloud”. 

3. Log in to the Fabasoft Cloud if you are not already logged in. 
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4. Enter a search term. You can also filter the search result if necessary. 

5. Drag and drop an image from the search result into your document. 

The image will be embedded in your document. 


	1  Introduction
	2  Digital Asset Management Dashboard
	3  DAM Configuration
	3.1  Getting Location Information From Images
	3.2  Configuration of Adobe Stock

	4  Asset Shelves
	5  External Areas
	6  Assets
	7  Registering Assets
	8  Re-Registering Assets
	9  Converting Assets
	10  Downloading Assets
	11  Tagging Assets
	12  Public Links to Assets
	13  Using Transfer Collections
	14  Integration in the Adobe Creative Cloud

